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The most obvious change from the previous versions is that Navigator 4.0  
now makes up part of the Communicator suite of programs. In addition 
to Navigator, the Communicator umbrella covers Netscape's Messenger 
mail client, Collabra conferencing, Composer HTML editor, and the 
SuiteSpot family of Internet server software. Navigator includes easy-to-
use tools for jumping between whatever Communicator components you 
have installed, but you can still install Navigator by itself if you don't 
need any of Communicator's other features. 
 
 
 

What Are the Parts of Navigator's 
Interface? 
 
When you first start Navigator 4.0, by default it will take you to 
Netscape's home page at http://home.netscape.com.  
 
 
 
 

Controlling Navigator's Toolbars 
 
You can control the toolbars you see in Navigator's window in several 
ways. First of all, you can show or hide any of the toolbars with the 
appropriate menu commands. These commands are described in the 
following list:  
 
• You control the Personal, Location, and Navigation toolbars with 
commands in the View menu. View, Show Navigation Toolbar or View, 
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Show Location Toolbar or View, Show Personal Toolbar will show the 
toolbars in the browser window. When the toolbars are already shown, 
the View menu commands will change to say "Hide" instead of "Show." 
 
• Each toolbar has a small striped border on its left side. Clicking this 
border makes the toolbar collapse. You can uncollapse a toolbar by 
clicking once again on its border, and it will go back to where it was 
when you collapsed it. 
 
• The Communicator, Show Component Bar command lets you hide and 
show the component bar. Unlike the other toolbars, the component bar is 
dockable, so you can grab it and place it anywhere on your screen.  
 

 
 
You can also tell Navigator how to display the toolbars themselves. By 
default, each toolbar item has an icon and a text label, but you can 
choose to use icons or text alone if you prefer. Here's how to change the 
toolbar labeling:  
 
 
1. Open Navigator's Preferences dialog with the Edit, Preferences 
command. 
 
2. Choose the Appearance item in the Category list.  
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3. Choose the type of labeling you want with the buttons in the Show 
Toolbar As group: Pictures and Text, Pictures Only, or Text Only. 
 
4. Click OK to apply your changes and close the dialog box. 
 
 
Opening a Web Page 
 
There are several different ways to open Web pages within Navigator:  
 
• The File, Open Page (Ctrl+O) command lets you type an URL or file 
name in to jump directly to that page. You can type an URL into the field, 
or use the Choose File button to select a file on your computer.  
 
• You can type an URL directly into the Location toolbar. When you hit 
Enter, Navigator will begin loading that page.  
 
TIP: Navigator tries to be smart enough to interpret what you type into the 
Location toolbar. If you just type a single word, like Apple, Navigator will first 
look for an Internet machine named "Apple," then for www.apple.com. 
Navigator will also auto-complete entries when possible, so typing home.n will 
be enough for Navigator to suggest home.netscape.com as the URL you want. 
 
• You can jump to a site on your bookmark list by choosing it from the 
Bookmarks menu, which is part of the Location toolbar. 
 
 
Opening a Web Page from the History List 
 
Once you've visited a Web page, Navigator keeps track of it so you can go 
back to it later. This list of pages you've already seen is called the history 
list, and Navigator gives you access to it in several ways:  
 
• The URL field in the Location toolbar is actually a combo box. Clicking 
the downward-pointing triangle to the right of the URL field will pop up a 
list of the last several pages you've visited; choose a page from this list to 
go back to it. 
 
• The Go menu keeps track of the same history as the URL field's combo 
box. The first 10 URLs in the Go menu have shortcuts; for example, Go, 
5 will take you to the fifth-most-recently visited site in your history list. 
Both the URL field and the Go menu are cleared when you exit Navigator 
and restart.  
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A bigger version of the history list is available in the History window; to 
see this window, use the Communicator, History command or press 
Ctrl+H. When the History window opens, you can sort its entries by 
clicking the column headers; to open any link in the window, either 
double-click it or drag it from the History window to an open browser 
window. 
 
 
 

Opening a Second Browser Window 
 
It's often useful to have more than one browser window open. You might 
want to alternate between several different sites, reading one while you 
wait for others to load, or you might want to compare two or more pages 
so you can comparison-shop. Navigator makes it easy to open additional 
windows; all you need to do is use the File, New, New Navigator Window 
(Ctrl+N) command. Navigator will open a new window and load your 
specified home page into it; you can then jump to another page without 
losing the contents of other windows. 
 
You can freely close additional browser windows; however, when you 
close the last open browser, news, or mail window, Navigator will exit.  
 
 
Opening New Pages in Their Own Windows 
 
Sometimes, you'll want to see where a link on a page leads without 
leaving that page. Navigator provides two ways for you to do this. The 
first way is to just open a new browser window, then use it to open the 
URL you want to visit. This isn't hard, but it does require you to shift 
your attention away from what you're reading. 
 
The second way is much easier: Right-click the link you want to open (or 
click and hold the button if you're using a Macintosh). Navigator will pop 
up a menu over the link; choose the Open In New Window command and 
the link will open in its own window, which you can move, minimize, or 
resize as you want--all without interfering with whatever you're reading. 
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Setting Your Default Home and Start 
Pages 
 
Even if you don't have your own home page, you can still tell Navigator 
what page to use when you click the Home button on the Navigation 
toolbar or use the Go, Home command. You can do this with Navigator's 
Preferences dialog box; here's what you need to do:  
 
1. Open the Preferences dialog box with the Edit, Preferences command. 

 
2. Choose the Navigator category from the Category list. 
 
3. Type the URL of the page you want to use as your new home page into 
the Location field. If the page is already open in your browser, you can 
click the Use Current Page button to use it. If the page you want to use is 
on your computer, the Browse button will let you navigate around your 
disk and find it. 
 
4. Click OK to save your choice. To test it, click the Home button on the 
Navigation toolbar; Navigator should load the page you just specified.  
 
 
 
Navigator gives you three choices for what page it loads when you open a 
new window. The option buttons in the Navigator Starts With area shows 
what happens when you open a window:  
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• The Blank Page option leaves new windows empty when you open 
them; this is the fastest option, since Navigator doesn't have to load 
anything when it creates a new window. 
 
• The Home Page option loads your home page into each new window. 
This can be very useful if your home page is a list of frequently visited 
links or a search engine. 
 
• The Last Page Visited option goes back to the last page you had loaded 
before the new window was opened--either the last page you visited 
before quitting Netscape the last time, or the page that was active when 
you opened the new window. 
 
 
 

Saving Web Pages 
 
Navigator allows you to save the contents of a Web page onto your local 
computer. This enables you to store pages so you can review them later 
or edit them. You can also save individual images or single frames on a 
page, and you can e-mail any page or part of a page to anyone you like.  
 
• To Save an Entire Page When you're looking at a page in Navigator, 
you can save it with the File, Save As... command. Netscape will open the 
standard Save File dialog box, with an additional pop-up menu that 
allows you to choose what format the file will be saved in. Choose Text if 
you want to save just the contents of the file (no HTML formatting will be 
kept). The resulting plain text can be imported into any word processor, 
mail program, or other application that lets you open ordinary text files. 
 
NOTE: If you choose Source from the pull-down menu, Navigator will save the 
file as HTML so you can edit it with an HTML editor or load it into Navigator 
later with the File, Open Page command described earlier.  
 
• To save a file that's linked to a Web page Right-click the link and 
choose the Save Link As command. Navigator will display the standard 
Save File dialog box to ask you where you want the file to be saved, then 
it will start downloading it to that location. You can then follow other 
links on the same page or even jump to a completely different page while 
Navigator downloads the file you specified. This trick works for links to 
files on FTP sites, links to Web pages, or links to any other kind of file.  
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NOTE: Navigator allows you to download these files in a separate window 
without tying up your browser--you'll see a separate download progress window 
for each download you have in progress.  
 
• To save a single frame from a Web page Tell Navigator which frame 
you want to save by clicking it. As soon as you click a frame, the File, 
Save Frame As command is enabled. When you select it, you'll be able to 
save the frame as text or HTML, just like the ordinary command to save 
an entire page.  
 
CAUTION: Be careful that you save the actual frame and not the frameset (the 
special type of file that frames are built with), or you will see links to the frames 
(and not the frames themselves) when you open the file. 
 
 
 

Saving Images on a Web Page 
 
Saving individual images from Web pages is a great way to copy pictures 
that you'd like to use as desktop wallpaper or even in Web pages you 
create yourself. Navigator offers three ways to save an image that 
appears on a page you're looking at:  
 
• Right-click the image, then choose the Save Image As command. When 
the File Save dialog appears, choose a folder and name for the image, 
and Navigator will download it and store it for you. 
 
• Use the left mouse button to drag the image out of the browser window 
into the window of an application, which supports drag-and-drop. For 
example, dragging an image to the Finder on the Macintosh will save the 
image as a JPEG or GIF file. 
 
• Under Windows 95, Windows NT, and the Macintosh OS, you can drag 
the image from its spot in the Navigator window to the desktop; Navigator 
will save the image as a JPEG or GIF file. 
 
• The last way to save an image requires that you first open it in a 
window by itself. You can do this by right-clicking the image, then 
choosing the View Image command. When the image appears, use the 
File, Save As command to save it as a GIF or JPEG image. (Of course, if 
you want the image to appear in its own new window, you can right-click 
the image and use the Open In New Window command to open a new 
window with only that image in it 
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TIP: On a Windows 95 machine, you can quickly grab an image from a Web 
page and turn it into your desktop wallpaper pattern with a single command. 
Right-click the image you want and choose Set As Wallpaper; Navigator will 
download the image and save it as a background pattern named "Netscape 
Wallpaper." Once that's done, it will tell Windows to start using it as a 
background pattern. Navigator will covert the image to the correct format, and 
by default center it on your desktop. You can then manipulate the image by 
selecting "Display" in the Control Panel. 
 
 
 

Sending Pages to Other People 
 
You can easily send pages to anyone. Navigator's File, Send Page 
command lets you use Netscape Messenger to send a complete page and 
its URL wherever you'd like. When you use this command, Navigator 
takes the text of the Web page and attaches it to the mail message as a 
separate file. Here's what to do:  
 
1. Go to the page you want to send. 
 
2. Choose the File, Send Page command. Navigator will open a new mail 
message window. Notice that Navigator includes the URL of the page in 
the message text.  
 
3. Address the message to its recipient. If you'd like, you can also add 
other file attachments or secure the message with digital signatures or 
encryption. 
 
4. Send the message by using the Send toolbar button. 
 
 
 

Using Navigator Offline 
 
Navigator includes a new feature, offline mode, that lets you minimize 
the amount of time you spend online. When switching from online to 
offline mode, Navigator can send any messages waiting to be sent and 
pick up any new messages that are waiting for you. Once you're in offline 
mode, you can answer news or mail messages, create new messages, and 
view Web pages stored on your local machine. When you go back online, 
Navigator will send the messages you created while offline, and you can 
surf the Web normally. 
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Navigator will tell you when you're in offline mode by putting a message 
into the browser window's status bar. If you try clicking a link or opening 
a new page from the Web while offline, Navigator will present a dialog box 
to remind you that you're offline and tell you how to get online.  
 
 
Controlling What Mode Navigator Starts In 
 
You can set a preference that tells Navigator what mode you want to start 
with; this is a good way to prevent unnecessary switching. To set the 
startup mode, you'll need to use the Offline category of the Preferences 
dialog box. Follow these instructions:  
 
1. Open the Preferences dialog box with the Edit, Preferences command, 
then choose the Offline category from the Category list. 
 
2. When the Offline category appears, choose a mode:  
 

• If you want to always start up in online mode (for example, if 
you've got a permanent Internet connection), choose the Online 
Work Mode button. Navigator will assume it's online unless you 
manually switch modes. 

 
• If you want to always start up in offline mode, as you might when 
your connection to the Internet is via modem, choose the Offline 
Work Mode button. Navigator will remain offline until you switch 
modes. 

 
• If you want Navigator to ask you each time it starts what mode to 
use, choose the Ask Me button. 

 
3. Click OK to save your changes. Navigator will start with the mode you 
select next time you run the program.  
 
 
Switching Between Offline and Online Modes 
 
Navigator uses two commands in the File menu: Go Online and Go 
Offline. Which one you see depends on the mode you're presently in; if 
you're online, you'll see the Go Offline command and vice versa. 
 
When you move from offline to online, or vice versa, there are three 
things you can do:  
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• You can send any messages waiting in Messenger's Outbox. The Send 
Messages check box tells Navigator whether to send those messages or 
not. 
 
• You can fetch any new mail that's waiting for you on your mail server. 
Use the Download Mail check box to tell Navigator whether it should 
download any new mail for you or not before switching modes. 
 
• You can download any new news or discussion articles for later reading 
by checking the Download Discussion Groups  
 
 
Telling Navigator What to Download 
 
Fortunately, Navigator gives you a good degree of control over what it 
downloads for you when switching between modes. If you read a lot of 
Usenet news, you'll appreciate the ability to fine-tune both which groups 
Navigator retrieves and when it does so; this fine-tuning can save you 
extra time. 
 
The Download subcategory of the Offline preferences panel lets you 
specify what items to download and when. Here's how to use it:  
 
 
1. Open the Preferences dialog with the Edit, Preferences command; then 
choose the Offline category from the Category list. 
 
2. Expand the Offline category by clicking the icon to the left of the word 
"Offline"; you'll see the Download subcategory appear beneath the Offline 
category. 
 
3. Use the controls in the Discussion Group Messages group to select 
which messages you want loaded. The Download Only Unread Messages 
check box tells Navigator not to re-download old messages you've already 
read. The Download by Date check box lets you use the "from" and 
"since" controls to get all the unread messages of a certain age. For 
example, you might want to download all the unread messages from 
seven days ago if you've been on vacation for the last week. 
 
4. Use the "Select Messages" button; you can then pick individual 
discussion groups whose messages you want to download (or not). 
 
5. Click OK. Navigator will save your preferences and use them next time 
you download messages when switching between modes. 
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Printing Web Pages 
 
The first step to printing is telling Navigator how you want the finished 
output to look. You do this with the File, Page Setup command. 
 
You can also get an exact preview of what your printed pages will look 
like before they hit the paper. With ordinary documents, you can predict 
where page breaks will fall; sometimes that's difficult with long Web 
pages, so being able to get a preview is particularly useful. 
 
TIP: If you're viewing a page with frames, you can choose to print only a single 
frame if you prefer. This is often helpful if you want to extract the useful 
information from a page that has several frames without getting the extraneous 
stuff, too. 
 
As with saving a single frame, the first step in printing just one frame is to click 
the frame. Then, use the File, Print Frame command, which replaces File, Print 
for framed pages, to bring up the standard print dialog and get your frame's 
data onto paper.  
 
 
 

Using Bookmarks to Find Your Favorite 
Sites 
 
One of Navigator's best time-saving features is its ability to keep a list of 
pages you want to visit again. These bookmarks give you quick access to 
pages without having to remember cryptic URLs; each bookmark has a 
description (which you can edit) to remind you what's on that page. 
 
Bookmarks actually appear in several places within Navigator. On 
Windows machines, there's a Bookmarks menu in the Location toolbar, 
while on the Macintosh, it's in the system menu bar. On both platforms, 
the Communicator menu has a Bookmarks command (Ctrl+B), which 
opens the Bookmarks window. 
 
Navigator organizes bookmarks the same way you keep files on your 
computer's hard drive: It uses folders to group similar items, and it can 
nest folders and items to help you keep your data organized and legible. 
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Some other organizational issues to keep in mind about bookmarks:  
 
• You can reorder bookmarks just by dragging them around; in addition, 
you can move them into and out of folders by dragging them 
appropriately. You can also delete and rename bookmarks--to delete one, 
select it and press the Delete key, and to rename one, click its name and 
the name will turn into a block of editable text. By default, when you add 
new bookmarks, they'll end up at the end of your list. 
 
• If you want to group bookmarks, you can do so by putting them in a 
folder. Once you've created a new folder, you can drag bookmarks into it 
to group them. You can also create separators in the list with the File, 
New Separator command; separators don't do anything except provide 
visual breaks in the list to emphasize related items. 
 
• You can arrange your bookmarks and folders in alphabetical order with 
the View, Sort Ascending and View, Sort Descending commands; this is 
often useful when your bookmark list has grown and lost any semblance 
of order.  
 
 
Adding a New Bookmark 
 
When you see a page that you want to come back to later, add a 
bookmark for it. Navigator offers several different ways to do so; here are 
the most commonly used:  
 
• Use the Add Bookmark command (Ctrl+D), which will automatically 
add the current URL to the end of your bookmarks list. 
 
• Click the bookmark icon in the Location toolbar; it does the same thing 
as the Add Bookmark command. 
 
• Drag any link on a Web page into the Bookmarks window; the link will 
be added wherever you drop it. 
 
• Right-click a link and use the Add Bookmark command; the link will be 
added to the end of your bookmark list. 
 
• When the Bookmarks menu is open, use the File, New Bookmark 
command. When the new bookmark dialog box appears, fill in the URL 
and your name for the bookmark. 
 



Using the Internet                                                             
Using Netscape Navigator 4.0                                                                                 30      
 
 
• You can tell Navigator to automatically save all new bookmarks in a 
particular folder. Use the File Bookmarks command in the Bookmarks 
menu, then choose the folder you want your new bookmarks to go into. 
Navigator will save all new bookmarks there until you specify otherwise.  
 
 
Going to Bookmarked Pages 
 
Netscape made bookmarks easy to get to so you'll be able to use them to 
organize your surfing. There are many different ways to open a page from 
your bookmark list:  
 
• Choose a bookmark from the Bookmark menu and Navigator will take 
you there immediately. 
 
• Double-click a bookmark in the Bookmarks window or use its File, 
Open Bookmark command; Navigator will use the frontmost browser 
window to display the bookmark's URL. 
 
• Drag a bookmark out of the Bookmarks window into an open browser 
window; the contents of the window will be replaced by the contents of 
the bookmark's URL.  
 
 
Seeing Which Bookmarks Have New Content 
 
When the Bookmarks window is open, choosing the View, Update 
Bookmarks command will present a dialog box which asks whether you 
want to check all bookmarks in your list or only the ones you currently 
have selected. When you click OK in that dialog box, Navigator will start 
checking the bookmarks in the background. You can still look at other 
Web pages while it's updating; as it reaches each page, it will mark the 
changed pages by putting an icon next to their bookmarks. When it's 
finished searching, Navigator will present a dialog box telling you how 
many bookmarks it checked and how many had new content.  
 
 
Saving Bookmarks on the Desktop 
 
If the bookmark feature isn't quite fast enough for you, Navigator has an 
alternative--it can create shortcuts on your desktop that lead to the 
bookmark of your choice. This is a great way to provide desktop access to 
your favorite pages, and it's easy to do: Just select the bookmark you 
want a shortcut for and use the File, Create Shortcut command. If you 
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select a bookmark before using this command, Navigator will fill in the 
New Internet Shortcut dialog with the name and URL of the bookmark; 
otherwise, you'll have to fill that in yourself. When you select OK in the 
dialog box, Navigator will create a shortcut (with the default name of 
"Shortcut To" followed by the bookmark name) on your Windows 
desktop.  
 
 
Controlling Bookmark Folders 
 
Navigator gives you control over three additional special folders with 
commands in the View menu. You use all three of these commands the 
same way: Select the folder you want to use, and then choose the 
command.  
 
• The View, Set As Toolbar Folder command lets you change which folder 
is used for the Personal Toolbar. By default, that folder is named 
Personal Toolbar, but you can use any bookmark folder as the source of 
your Personal Toolbar items. 
 
• The View, Set As New Bookmark Folder command enables you to 
choose where new bookmarks are stored when you create them. By 
default, they'll go into the topmost folder, but you can create a folder for 
your new bookmarks and set it as the target with this command. 
 
• The View, Set As Bookmark Menu command lets you pick the folder 
that's used as the source for the Location toolbar's bookmark menu. Use 
this command to pick a folder with a subset of your most frequently 
visited pages, and you'll have easy access to them from the Location 
toolbar. 
 
 
 

Increasing Your Browsing Speed--Turning 
Off Images and Java 
 
Most Web pages contain graphics, and these graphics often take much 
longer to download than the surrounding text. Wouldn't it be nice to 
quickly get the page text and then to decide whether to load images on 
that page or not? Navigator gives you just such a feature; you can turn 
off image loading by default, then load individual images, or all the 
images on a particular page, when you decide there's something you 
need to see. 
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Likewise, Java applets often take a long time to download; when your 
computer finally finishes, your patience may be rewarded by something 
silly like a scrolling marquee. You can turn off Java applets so that 
Navigator won't download them by default. 
 
Here's how to enable these two speed-building options:  
 
 
1. Open the Preferences dialog box with the Edit, Preferences command. 
 
2. Choose the Advanced category from the Category list. You'll see the 
dialog shown.  
 

 
 
3. To turn automatic image loading off, clear the Automatically Load 
Images check box. 
 
4. If you want to keep Navigator from running Java applets, clear the 
Enable Java check box. 
 
5. Click OK to save your changes and dismiss the dialog box.  
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When you're viewing a page and you want to see its images, you can do 
one of two things. To load all the images on the page, use the View, Show 
Images command, and Navigator will load any missing images and 
display them. If you just want to see one image, right-click it and use the 
View Image command on the menu. 
 
 
 

Increasing Your Browsing Speed--Use 
Navigator's Cache 
 
Every time you download a file--whether it's an HTML Web page, a 
sound, a picture, or anything else that appears on a Web page--Navigator 
adds it to the cache. When you load a page, Navigator first checks its 
cache to see if there's a local copy on your computer before sending data 
to the network. If there's already a current copy of the page on your 
computer, Navigator will load and display it instead of making you wait 
while it fetches the page again from the remote server. 
 
Caching can greatly speed your Web browsing if you often revisit a set of 
pages that don't change very often; the time savings from never loading 
duplicate copies of a page can add up. 
 
You control how Navigator's cache works with the Cache subcategory of 
the Advanced category in the Preferences dialog box. To reach this dialog 
box, open the Preferences dialog box with the Edit, Preferences 
command, then choose the Advanced category and expand it until you 
see the Cache subcategory. Click Cache to see the preferences pane. 
 
Here's what you can do with the cache preferences dialog box:  
 
• Navigator actually keeps two copies of the cache: The memory cache 
holds the most recently visited pages, and the disk cache holds older 
pages. You can use the Memory Cache and Disk Cache fields to change 
the relative sizes of these two caches. Changes take effect the next time 
you run Navigator. 
 
• The Clear Memory Cache and Clear Disk Cache buttons empty out the 
appropriate caches. Navigator will purge all files in the cache when you 
click the corresponding button. 
 
• You can put the cache anywhere on your system. By default, Navigator 
will put it in a subfolder of the folder where it's installed, but you can 
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change it. The Disk Cache Folder field and the associated Choose Folder 
button allow you to change the folder location, which gives you freedom 
to specify a large cache and put it on whatever disk you have the most 
space on. 
 
• Navigator can compare the cached and remote versions of a document 
in three ways: The Never button tells Navigator to always reload the 
document from the network; the Every Time button tells it to compare 
modification times every time you open a page, and Once Per Session 
makes the comparison the first time you visit a page during one run of 
Navigator. 
 
 
 

Controlling Disk Space Usage 
 
Left unchecked, mail and news can take up your entire disk almost 
before you know it. If you're not in the habit of deleting old mail and 
news articles, they'll hang around until your storage space is all gone. 
Navigator offers some features to keep disk usage under control by 
limiting how much space Navigator uses for news and mail messages. 
 
To open the dialog box, use the Edit, Preferences command, then choose 
the Advanced category and expand it until you see the Disk subcategory. 
 
The All Messages group controls downloading of mail and discussion 
group messages. The Do Not Download Any Message Larger Than X kB 
control sets an upper limit for the size of messages that Navigator will 
retrieve; messages that are bigger than the threshold will stay on the 
server until you explicitly ask for them. The Automatically Compact 
Folders controls let you trigger automatic compression of files and folders 
when doing so will save more than the specified amount of space. 
Compression takes time, so setting this to a reasonable value (at least 
256K) is recommended. 
 
Discussion groups are always changing; new messages flow in 
constantly, and old messages eventually expire and disappear from the 
server. Navigator will periodically clean up its stash of messages on your 
machine, but you can control which messages are kept with the controls 
in the Discussion Groups Messages Only group. When Navigator cleans 
up messages, you can choose which ones get kept: messages that arrived 
within a predefined period, all messages, or a certain number of new 
messages. In addition, you can tell Navigator to throw away any 
messages you've already read with the Keep Only Unread Messages 
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check box, but this option will keep you from being able to go back and 
reread a message after it's expired from the server. 
 
 
 

Surfing with a Proxy Server 
 
The second key configuration item in the Advanced category is the one 
for proxy servers. All the computers on a network can use a single proxy 
to streamline the process of pulling pages down from the Internet. 
Network administrators like proxy servers for a different reason, too: 
Proxies offer better security than direct Internet connections, and-- a 
great boon to corporate intranets-- they can be used to keep users from 
loading "undesirable" or non-business-related URLs. 
 
Navigator gives you three choices for proxy use.  
 
• The first, most common, choice is the default: no proxy at all, 
represented by the Direct Connection to the Internet button. You'll 
probably be using this option if you're connecting to the Net from home 
or work via PPP. 
 
• The second choice is a self-configuring proxy. Netscape's proxy servers 
offer this option; if your network administrator tells you to use an 
automatic proxy, she'll give you an URL. You'll need to select the 
Automatic Proxy Configuration button, then put the URL into the 
Configuration Location (URL) field and click Reload. 
 
• The final choice is more complicated, though, and you'll need it if you're 
using an ordinary, manually configured proxy. Your network 
administrator will have to give you a list of proxy server names and port 
numbers. When you get the list, open the proxy dialog, choose Manual 
Proxy Configuration, and then click the View button. You'll see a dialog 
box like the one shown in Figure 11.14; just fill in the machine name and 
port for each service from the list your administrator gave you and click 
OK. 


